SEMANTIC WS-AGREEMENT PARTNER SELECTION

by

NICOLE OLDHAM

(Under the direction of Amit P. Sheth)

ABSTRACT

In a dynamic service oriented environment it is desirable for service consumers and providers to offer and obtain guarantees regarding their capabilities and requirements. WS-Agreement defines a language and protocol for establishing agreements between two parties. The agreements are complex and expressive to the extent that the manual matching of these agreements would be expensive both in time and resources. It is essential to develop a method for matching agreements automatically. This work presents the framework and implementation of an innovative tool for the matching providers and consumers based on WS-Agreements. The approach utilizes Semantic Web technologies to achieve rich and accurate matches. A key feature is the novel and flexible approach for achieving user personalized matches.

SEMANTIC WS-AGREEMENT PARTNER SELECTION

by

NICOLE OLDHAM

B.S., North Georgia College and State University, USA, 2002

A Thesis Submitted to the Graduate Faculty of The University of Georgia in Partial Fulfillment

of the Requirements for the Degree

MASTER OF SCIENCE

ATHENS, GEORGIA

2006
© 2006

Nicole Oldham

All Rights Reserved
SEMANTIC WS-AGREEMENT PARTNER SELECTION

by

NICOLE OLDHAM

Major Professor: Amit P. Sheth

Committee: John Miller
   Hamid Arabnia

Electronic Version Approved:

Maureen Grasso
Dean of the Graduate School
The University of Georgia
May 2006
DEDICATION

This thesis is dedicated to my father; Mike, without whom it would not exist, and to my mother;

Sonya, for all of her support.
ACKNOWLEDGEMENTS

I would like to thank my advisor Dr. Amit P. Sheth for his direction, assistance and guidance. My graduate work was more rewarding and enriched under Dr. Sheth’s direction. I would also like to thank Dr. John A. Miller for his valuable insight and wisdom. I would like to thank Dr. Hamid Arabnia for being a part of my committee and for all of the advice and guidance throughout the last two years. Thanks to the entire Meteor-S team and special thanks to Kunal Verma for his advice and help in making this work something to be proud of. I must express my gratitude to my parents for the sacrifices that they have made to ensure that I could make it to this point and for the support and encouragement. Thank you to my husband, Heath, for always having more faith in me than I had in myself and for his unaltering support.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>ACKNOWLEDGEMENTS</th>
<th>v</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIST OF TABLES</td>
<td>vii</td>
</tr>
<tr>
<td>LIST OF FIGURES</td>
<td>viii</td>
</tr>
<tr>
<td>CHAPTER</td>
<td></td>
</tr>
<tr>
<td>1. INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td>2. MOTIVATION FOR A SEMANTIC APPROACH</td>
<td>3</td>
</tr>
<tr>
<td>3. WS-AGREEMENT AND WS-AGREEMENT MATCHING</td>
<td>5</td>
</tr>
<tr>
<td>4. SEMANTIC WS-AGREEMENT PARTNER SELECTION</td>
<td>13</td>
</tr>
<tr>
<td>5. APPLICATION OF WS-AGREEMENTS AND AGREEMENT MATCHING</td>
<td>31</td>
</tr>
<tr>
<td>6. RELATED WORK</td>
<td>36</td>
</tr>
<tr>
<td>7. CONCLUSION AND FUTURE WORK</td>
<td>39</td>
</tr>
<tr>
<td>REFERENCES</td>
<td>41</td>
</tr>
<tr>
<td>APPENDICES</td>
<td></td>
</tr>
<tr>
<td>A WS-AGREEMENT ONTOLOGY</td>
<td>45</td>
</tr>
<tr>
<td>B SWAPS INSTALLATION MANUAL</td>
<td>46</td>
</tr>
<tr>
<td>C SWAPS USER MANUAL</td>
<td>48</td>
</tr>
</tbody>
</table>
# LIST OF TABLES

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 1</td>
<td>Guarantee Term Components</td>
<td>6</td>
</tr>
<tr>
<td>Table 2</td>
<td>SWAPS extensions to the WS-Agreement schema</td>
<td>7</td>
</tr>
<tr>
<td>Table 3</td>
<td>Summary of Consumer Guarantees</td>
<td>24</td>
</tr>
<tr>
<td>Table 4</td>
<td>Summary of Guarantees from Provider Library</td>
<td>24</td>
</tr>
<tr>
<td>Table 5</td>
<td>SWAPS Matching</td>
<td>26</td>
</tr>
<tr>
<td>Table 6</td>
<td>Evaluation Results</td>
<td>29</td>
</tr>
<tr>
<td>Table 7</td>
<td>Farming Contracts represented with WS-Agreement</td>
<td>32</td>
</tr>
</tbody>
</table>
# LIST OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1</td>
<td>Linking Web Service and Web Service Agreement Concepts with Ontologies</td>
<td>10</td>
</tr>
<tr>
<td>Figure 2</td>
<td>Benefits of the OntConcept Annotation</td>
<td>12</td>
</tr>
<tr>
<td>Figure 3</td>
<td>Control Flow throughout SWAPS</td>
<td>14</td>
</tr>
<tr>
<td>Figure 4</td>
<td>SWAPS Architecture</td>
<td>16</td>
</tr>
<tr>
<td>Figure 5</td>
<td>Conversion of Heterogeneous Service Level Objectives</td>
<td>18</td>
</tr>
<tr>
<td>Figure 6</td>
<td>The Provider Library</td>
<td>49</td>
</tr>
<tr>
<td>Figure 7</td>
<td>Consumer Guarantees</td>
<td>50</td>
</tr>
<tr>
<td>Figure 8</td>
<td>Match Results</td>
<td>51</td>
</tr>
</tbody>
</table>
CHAPTER 1

INTRODUCTION

In a service oriented environment it is advantageous for service consumers and providers to obtain guarantees regarding the services that they both require and offer. Usually these guarantees pertain to quality of service (QoS) aspects. WSDL does not provide a means to express these guarantees; therefore such standards as WS-Policy [23] and WSLA [25] exist to allow for the expression of additional nonfunctional attributes. However, these standards are not expressive enough to represent the truly complex nature of the relationship between a service consumer and provider. The WS-Agreement specification [2] defines a language and protocol for capturing this intricate relationship with agreements between two parties. An agreement between a service consumer and a service provider specifies one or more service level objectives (SLO) which state the requirements and capabilities of each party on the availability of resources and service qualities. For example, an agreement may provide assurances on the bounds of service response time, service availability, or service reliability. WS-Agreement is more expressive than the previous policy standards because in addition to service level objectives, an agreement contains scopes for which the guarantee holds, conditions which must exist in order for the guarantee on the SLO to be valid, and business values, such as penalties and rewards, which incur if the SLO is not satisfied. This is further complicated by the symmetry of these agreements such that each provider does not only state guarantees regarding capabilities but likely has requirements of its own. In addition, each agreement may contain multiple alternatives of guarantee sets. As each consumer seeking a
suitable provider has many complex options to choose from, the manual selection of providers is time consuming, tedious, and error prone. With the increasing acceptance and popularity of WS-Agreement and the ever present need to protect the quality of service with guarantees, the development of an approach for the automatic matching of these agreements is imperative.

This paper defines and provides reasoning methods for the components of an agreement which must be compatible for quality matches. We present a powerful approach which uses OWL ontologies to represent domain knowledge in conjunction with SWRL rules to achieve the most accurate and consumer personalized matches. The contributions of this work include:

- Creating and implementing a framework for automated matching of provider and consumer agreements that eliminates tedious and error prone manual matching.
- Use of multiple ontologies, both domain specific and domain independent for representing semantic information used by the agreements.
- Presenting a flexible approach for specifying and reasoning over user defined preferences which allows the customized matching without changing matching code or possessing programming knowledge.

The remainder of this paper is organized as follows. Section 2 presents the motivation for our approach. Section 3 briefly covers the WS-Agreement schema and the general process of WS-Agreement matching. Section 4 is composed of details on our framework and implementation of Semantic WS-Agreement Partner Selection (SWAPS). Section 5 presents a real world situation which would benefit from the use of WS-Agreements and illustrates the necessity of an efficient tool for matching consumers with providers. Section 6 discusses related work, and Section 7 provides conclusions and future work.
CHAPTER 2

MOTIVATION FOR A SEMANTIC APPROACH

The current WS-Agreement specification is based on XML based domain vocabularies and therefore limits the ability of matching the agreements to syntactical matching. Our approach proposes using domain knowledge captured using ontologies and rules to extend the matching capabilities beyond simple string matching. A matcher considering only the syntax of the agreements without the domain knowledge may not be able to correctly identify all matches. We illustrate the usefulness of our approach with the following example. Consider that a service consumer has the following requirement:

- Availability is greater than 95%

and a provider is offering the assurances:

- Mean Time to Recover equals 5 minutes
- Mean Time between failures equals 15 hours

A syntactic matcher would perform a string comparison to determine if the provider can satisfy the consumer’s request. The syntactic matcher would generally determine that these two services do not match on the grounds that the provider does not provide an assurance for availability. However, our approach utilizes an ontology which provides a deeper understanding of the domain with the help of domain rules. For example, with respect to the above case:

- Availability = Mean Time Between Failures/(Mean Time Between Failures + Mean Time To Recover)
Therefore the semantic approach reasons that the provider is actually offering the assurance:

- *Availability equals 99.4%.*

Our matcher determines that this provider does in fact satisfy the requirements of the consumer.

This example illustrates how incorporating using domain knowledge helps matching yield much more accurate matches.
This section briefly describes the WS-Agreement schema [2], the extensions that have been added for this work, and a general overview of the significant elements of WS-Agreement matching.

3.1. WS-AGREEMENT SCHEMA

WS-Agreement offers a rich language for stating the assurances and requirements of Web Services. This allows capturing and representing the complicated nature of real world agreements with the help of service level objectives (SLOs), qualifying conditions and business values. SLOs represent some capability or requirement of a provider or consumer. For example, the consumer may require that all response times be less than 5 seconds. However, in a real world environment these capabilities and requirements cannot be guaranteed under every circumstance. For instance, a service might only be able to process a job in less than 5 seconds if the number of requests at that moment is less than a thousand. Such conditions can be associated with SLOs with the help of qualifying conditions. Business values help in representing the importance, penalties, and rewards associated with SLOs.

WS-Agreements are written in XML and consist of alternative sets of guarantees denoted with the “ExactlyOne” and “ALL” tags. Due to the already complex nature of agreements, we save the WS-Agreement’s “OneOrMore” tag for future work and assume that all agreements are written as a
disjunction of alternative sets of guarantees. The guarantees are expressed within the
“GuaranteeTerm” tag and assert assurances or requirements on the quality associated with the
service. Below is the Guarantee Term schema followed by Table 1 which describes the
components of a guarantee term.

<wsag:GuaranteeTerm Obligated="…”>
  <wsag:ServiceScope ServiceName="…”>…
  </wsag:ServiceScope>*
  <wsag:ServiceLevelObjective> …
  </wsag:ServiceLevelObjective>
  <wsag:QualifyingCondition>…</wsag:QualifyingCondition>?
  <wsag:BusinessValueList>…</wsag:BusinessValueList>
</wsag:GuaranteeTerm>

Table 1: GuaranteeTerm Components

<table>
<thead>
<tr>
<th>WS-Agreement Tag</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obligated</td>
<td>States the party responsible for the fulfillment of the guarantee. Value will be ServiceProvider or ServiceConsumer</td>
</tr>
<tr>
<td>ServiceScope</td>
<td>Describes to what service element specifically a service applies.</td>
</tr>
<tr>
<td>ServiceLevelObjective (SLO)</td>
<td>An assertion over the terms of the agreement which represents the QoS aspect of the agreement. Usually defines bounds usually over QoS concepts such as response time, fault rate or cost.</td>
</tr>
<tr>
<td>QualifyingCondition</td>
<td>Optional condition which must exist in order for the SLO to be satisfied. Usually over external factors such as time of day.</td>
</tr>
<tr>
<td>BusinessValueList</td>
<td>Optional values which represent the strength of commitment by stating penalties, rewards and importance</td>
</tr>
</tbody>
</table>
3.2. WS-AGREEMENT EXTENSIONS

In order to achieve effective semantic matches, we extend the original WS-Agreement schema with several additional tags. The new tags allow for the incorporation of semantics into WS-Agreement and add additional structure for clarity during parsing and matching.

Table 2: SWAPS extensions to the WS-Agreement schema

<table>
<thead>
<tr>
<th></th>
<th>WS-Agreement Schema</th>
<th>SWAPS Schema</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLO</td>
<td>&lt;ServiceLevelObjective&gt; &lt;Parameter&gt;duration1+duration2 &lt; /Parameter&gt; &lt;OntConcept&gt;qos::responseTime &lt;Value&gt;5&lt;/Value&gt; &lt;Unit&gt;time:seconds&lt;/Unit&gt; &lt;/Predicate&gt;&lt;/Expression&gt;</td>
<td>&lt;ServiceLevelObjective&gt; &lt;Expression&gt; &lt;Predicate type=&quot;less&quot;&gt; &lt;Parameter&gt;duration1+duration2 &lt;/Parameter&gt; &lt;OntConcept&gt;qos::responseTime &lt;/OntConcept&gt; &lt;Value&gt;5&lt;/Value&gt; &lt;Unit&gt;time:seconds&lt;/Unit&gt; &lt;/Predicate&gt;&lt;/Expression&gt;</td>
</tr>
<tr>
<td>Qualifying Condition</td>
<td>&lt;QualifyingCondition&gt; &lt;Parameter&gt;dayOfWeek&lt;/Parameter&gt; &lt;OntConcept&gt;time:dayOfWeek&lt;/OntConcept&gt; &lt;Value&gt;time:weekday&lt;/Value&gt; &lt;/Predicate&gt;&lt;/Expression&gt;</td>
<td>&lt;QualifyingCondition&gt; &lt;Expression&gt; &lt;Predicate type=&quot;equals&quot;&gt; &lt;Parameter&gt;dayOfWeek&lt;/Parameter&gt; &lt;OntConcept&gt;time:dayOfWeek&lt;/OntConcept&gt; &lt;Value&gt;time:weekday&lt;/Value&gt; &lt;/Predicate&gt;&lt;/Expression&gt;</td>
</tr>
</tbody>
</table>

3.2.1. ADDING STRUCTURE TO SLO AND QUALIFYING CONDITIONS

The WS-Agreement specification was written with flexibility as one of the key goals and therefore lacks some structure in important areas such as the SLO and QualifyingCondition. The values within each of those tags can contain any possible expression. While this would be acceptable for
an agreement which is intended to be read by a human user, additional structure must be added to
the expressions in order to for a machine to automatically parse and reason over agreements.
However, we added this structure while still preserving much of the flexibility specifically for
domain specific predicates. For structure, we have added the expression, predicate, parameter, and
value tags, as defined in the WSLA specification [25]. In addition there are the optional tags for
unit and percent. Percent is used when a service level objective uses a percentage. For example,
99% of responseTimes are less than 5 seconds. Table 2 shows an example using the original
schema as defined in [2] which is too ambiguous to parse and reason over. Our modified schema
which adds structure is also shown in Table 2.

3.2.2 ADDING SEMANTICS TO THE WS-AGREEMENT

Agreements contain ambiguities which we clarify using an OntConcept annotation tag. In the
original schema of the Terms section of the WS-Agreement. Even though these variables have
already been defined within the service description terms, it is unclear to what the summation of
duration1 and duration2 actually refers. For example, it may refer to a QoS parameter
responseTime or it may refer to a domain concept processOrderDuration. The addition of the
OntConcept tag removes this ambiguity by linking this expression parameter directly to the
concrete ontology concept. The value of OntConcept will be a concept from an ontology
regardless of what variables are named and to what they refer. The agreement creators are required
to include this tag to allow for semantic reasoning over the expression. This yields more effective
matches than purely syntactic methods. The OntConcept tag clarifies the QoS or domain specific
parameter to which the objective pertains. Figure 2 contains an example illustrating how the
OntConcept tag remedies ambiguity. A syntactic matcher is not able to determine that (duration1+duration2) and processTime each refer to the response time of the service which is the concept responseTime in the QoS ontology. Adding OntConcept allows the matcher to recognize that although the concepts are syntactically different, they are semantically the same.

3.2.3. DOMAIN SPECIFIC PREDICATE FLEXIBILITY

When extending the WS-Agreement, we aimed to preserve much of the flexibility intended by the WS-Agreement authors. We designed a unique method for using domain specific predicates in the expressions. Any predicate may be used as long as it is added to the ontology and a rule is created to define the semantics of that predicate. The tool is already aware of the WSLA predicates less, lessEqual, greater, greaterEqual, equals, true, false, before. However the user is not limited to only these predicates and can define additional predicates for the domain.

3.3. SEMANTIC WEB SERVICES

Semantic Web Services (SWS) provide an approach for representing the functionality of Web services with the help of ontologies. Popular approaches for SWS include OWL-S [13], WSMO [26], FLOWS [19] and WSDL-S [17][27]. For the the purposes of this paper, we have implemented the prototype using ontologies. The OntConcept tag annotates the SLO and Qualifying Condition parameters which facilitates the understanding and matching of the guarantee terms of the agreement. The Agreement Service Description Terms (SDT) refer to the operations of the WSDL to which the Agreement pertains. These SDT are also used during the monitoring of the service
and negotiation. Both the XML based WSDLs and WS-Agreements are limited in their ability to express rich semantic meaning. In order to achieve the most accurate monitoring and negotiation the WSDL files to which the SDTs refer are semantically annotated using WSDL-S [27].

WSDL-S builds on current standards and allows multiple semantic representation languages to annotate services. This flexibility allows Web Services to be annotated with concepts from multiple ontologies from different sources. One of the most pressing challenges when mapping WSDL with ontologies is the heterogeneity between the XML Schema of the WSDL and the ontology, however, WSDL-S overcomes this challenge by providing support for rich mapping.

![Diagram of linking Web Service and WS-Agreement concepts with ontologies]

Figure 1: Linking Web Service and WS-Agreement concepts with ontologies
Figure 1 shows these mappings between an Agreement and Web Service, Agreement and ontology, and Web Service and Ontology, in the context of the contract farming use case which is described in Section 5 of this paper. WS-Agreement negotiations and the runtime monitoring of WS-Agreement compliance is facilitated and enhanced by the use of semantically annotated Web Services since the ontologies provide a common understanding of the functional properties of Web Services. These semantic annotations enrich negotiations by linking heterogeneously expressed service elements to a common ontological concept. They enhance the monitoring of WS-Agreement compliance by disambiguating the terms used within the agreements and WSDL files and by providing additional domain knowledge which can be used when monitoring.

3.4. WS-AGREEMENT MATCHING

In order for a provider to be considered a suitable partner match for a given consumer, its description must contain one alternative which may satisfy any of the consumer’s alternatives as denoted by the “ExactlyOne” and “ALL” tags. An agreement A contains alternative sets of Guarantee Terms such that:

\[ A = \{\text{Alt}_1, \text{Alt}_2, \ldots, \text{Alt}_N\} \]
\[ \text{Alt} = \{G_1, G_2, \ldots G_N\} \quad \text{and} \quad G = \{\text{Scope, Obligated, SLO, QC, BV}\} \]

We define the following functions to facilitate the description:

“requirement(Alt, G)” returns true if G is a requirement of Alt
“capability(Alt, G)” returns true if G is an assurance of Alt
“scope(G)” returns the scope of G
“obligation(G)” returns the obligated party of G
“satisfies(G_j, G_i)” returns true if the SLO of G_j is equivalent to
or stronger than the SLO of Gi

An alternative Alt1 is a suitable match for Alt2 if:

\((\forall Gi) \text{ such that } Gi \in \text{Alt1} \land \text{requirement(Alt1, Gi)} \land (\exists Gj)\)

\text{such that } Gj \in \text{Alt2} \land \text{capability(Alt2, Gj)} \land \text{scope(Gi)}

\equiv \text{scope(Gj)} \land \text{obligation(Gi)} = \text{obligation(Gj)} \land \text{satisfies(Gj, Gi)}

Most users have preferences for conditions and business values and a tradeoff is decided. For instance, a user may choose an agreement with a less preferred condition but a higher penalty. Alternatively, a user with a high number of requests on the weekend would find a provider to be unsuitable if he has a condition which states that he is only able to satisfy a guarantee if it is a weekday. We consider the tradeoff between qualifying conditions and business values to be a matter of user preference and have designed a unique and flexible method for specifying these user preferences in order to yield the most suitable matches. Our approach is presented in detail in Section 4.

Figure 2. Benefits of the ontConcept annotation
We present our framework and implementation in this section. We begin by describing the system architecture followed by how ontologies and rules were utilized to achieve better matches and to simplify the search algorithm. We then walkthrough an example which illustrates the reasoning methodology used by the tool.

4.1 ARCHITECTURE

The system consists of three phases: parsing, matching and searching, which can be seen in Figure 3. To reason about domain ontologies, we use Snobase [9], an ontology based management system that offers DQL-based [5] Java API for querying OWL ontologies. IBM’s ABLE engine [3] is used by Snobase for inferencing and we use ABLE Rule Language (ARL) [3] to write the rules. The ontologies are loaded into Snobase followed by each provider’s WS-Agreement. We parse the agreements and load them into the system as instances of the WS-Agreement ontology. As each of these new agreement instances is created, the ABLE rule engine within Snobase executes rules as the criteria for each rule is met. The additional assertions made by the rules are used to greatly simplify the search phase by making the match decisions a priori. These rules provide additional knowledge about the domain and, as described in Section 2, play a significant role in the discovery of the most accurate match results. We discuss the rules in further detail in the next section. When a consumer seeks a partner, the consumer agreement is parsed and entered into the system as
another agreement instance. The search phase begins as the algorithm considers the agreement instances and the assertions previously set by the rules and returns a list, ranked by preference, of all of the provider agreements which accurately matched the consumer’s agreement.

![Control flow throughout SWAPS](image)

**Figure 3: Control flow throughout SWAPS**

Figure 4 illustrates the system architecture. The main components of SWAPS include the ontology store, provider library, parser, ontology manager, and search engine. It is assumed that the consumer seeking a match has a library of agreement instances previously made between providers and is searching for the provider who is most able to satisfy the requirements. However it is also known that previously unknown providers, in the form of an agreement offer or a template, are constantly introduced into the set of options. Further details regarding the ontologies, rules and search engine are given in sections 4.2 and 4.3.

4.2. WS-AGREEMENT AND RULES REPRESENTATION

Ontologies allow the matcher to understand the semantics of the domain; therefore enabling a much more accurate search than a syntactic approach. Rules allow for richer domain knowledge by
stating additional domain rules and semantics and provide a high level of flexibility by stating customized user preferences.

4.2.1 KNOWLEDGE REPRESENTATION

In order to realistically model the domains we employ several ontologies. We developed an OWL ontology to represent the WS-Agreement schema. This ontology contains the concepts from the schema such as Guarantee, Scope, and ServiceLevelObjective with relationships between them. In addition to the significant elements from the WS-Agreement, we have also included the common predicates from the WSLA specification [25]. We allow the user to add additional predicates to this ontology to preserve flexibility. An instance of this ontology is created for each agreement that is introduced into the system where they can be queried and reasoned easily. Most of the guarantees are asserted over quality of service (QoS) concepts; therefore the QoS ontology as described in [12] defines such concepts as failureRate, latency, throughput, availability, and responseTime. In addition to these ontologies a third OWL ontology represents domain specific knowledge. For our scenario in e-commerce and its implementation we are using the RosettaNet ontology (http://lsdis.cs.uga.edu/projects/meteor-s/wsdl-s/ontologies/rosetta.owl), also represented in OWL. Depending on the application, alternative or additional domain ontologies could be used. Finally, we use the OWL time [14] ontology to represent temporal concepts such as endTime, interval, dayOfWeek, and seconds. These ontologies are used to provide a commonality of terms between agreement parties and to provide rich domain knowledge to the search engine so that it may achieve the best possible match results.
4.2.2 REPRESENTATION OF RULES

We enhance the efficiency and flexibility of our matches by defining several categories of rules. These rules are represented in ARL for ABLE inferencing. The rules assert new facts if the right conditions exist for executing the various rules. We use these rules to supplement domain knowledge, convert SLOs into a common comparable form, define the semantics of domain
specific predicates, and specify user preferences. Using rules instead of writing Java code to perform all of the above allows us to separate the core implementation from the user so that he may customize the matcher to the domain and personal preferences without any programming ability.

We define four categories of rules and show corresponding examples below.

1. Conversion of Heterogeneous SLOs

Often SLOs state the same objective but express it differently. We define a category of rules to address SLOs that have semantic similarity but are syntactically heterogeneous as in the example in Figure 5. In the example, the provider is expressing an assurance using the WSLA predicate “PercentageLessThanThreshold” and the consumer is expressing the same requirement more directly using the predicate “less”. While a human reader can clearly see that the provider’s SLO satisfactorily meets the consumer’s requirements, the heterogeneity of the predicates prevents the direct comparison of the provider and consumer SLOs. We define the following ARL rule, where $x$ is a user defined threshold, to convert the provider’s SLO so that it expresses the objective more directly:

**when:** Agreement (A) and hasGuarantee (A,G) and hasSLO (G, SLO) and hasExpression(SLO, E) and hasPredicate(E, P) and hasType(P, “PercentageLessThanThreshold”) and hasPercentage(E, percent)

**do:** if (percent<=$x$) then assert hasType(P, “less”) else assert hasType(P, “greater”)

The above ARL rule looks for any expression which contains the predicate “PercentageLessThanThreshold” and if the percentage less than $x$ it changes the predicate to “less” otherwise it changes it to “greater”. In many cases the value of $x$ is dependent upon the parameter. For example, a user may require a high percentage for responseTime but may be more lenient about other parameters. This feature
can be further customized by adding additional statements in the *when* segment which perform parameter checks.

**Figure 5. Conversion of Heterogeneous SLOs**

2. *Semantics of Predicates Rules*

The second category of rules allows a user to utilize any domain specific predicates within an SLO by defining how two SLOs with that predicate should be compared. A semantics rule should compare SLOs according to the predicate semantics and assert an *isStronger* or *isEquivalent* triple into Snobase. The following ARL rule defines the semantics of the predicate “less”.

**when:** Agreement (A1) and *hasGuaranteeTerm*(A1, G1) and *hasSLObjective*(G1, SLO1) and *hasExpression*(SLO1, E1) and *hasPredicate*(E1, P1) and *hasType*(P1, “less”) and *hasParameter*(E1, p1) and *hasValue*(E1, V1) and Agreement (A2) where A1 != A2 and *hasGuaranteeTerm*(A2, G2) and *hasSLO*(G2, SLO2) and *hasExpression*(SLO2, E2) and *hasPredicate*(E2, P2) and *hasType*(P2, “less”) and *hasParameter*(E2, p2) and p2 == p1 and *hasValue*(E2, V2)
do:  if (V1<V2) assert [E1 isStronger E2]
    else if (V1>V2) assert [E2 isStronger E2]
    else assert [E1 isEquivalent E2]

The above rule compares the values of SLOs from different agreements with the same predicate
and parameter and asserts isEquivalent if the values are the same otherwise it states which
expression is stronger based on the semantics of the predicate “less”. This rule can also be further
customized by incorporating parameters or checking units to determine whether to do a string or
numeric comparison. The benefit of this approach is two-fold. First, it allows for domain predicate
flexibility such that we do not restrict which predicates our matcher can compare but rather allow
the user to introduce new predicates by defining the semantics with an ARL rule. Second, since
rules are fired automatically as the agreements are being loaded into Snobase, the SLOs are
compared much before the search process. This simplifies the search algorithm because to find a
match for SLO1 we quickly query for all SLOs who have been asserted isStronger than or
isEquivalent to SLO1. The semantics of predicate rules have the lowest priority so that the other
rules may execute before the final evaluation is performed.

3. Domain Specific Rules

The domain rules provide the matcher with richer knowledge of the domain. The following
example is based on the scenario from Section 2. Consider the following domain rule for
Availability:

MTBF is the Mean Time Between Failures

MTTR is the Mean Time To Recover

\[ Availability = MTBF/(MTBF + MTTR) \]

Consider a provider agreement with the following guarantees:
Guarantee1: SLO: qos:MTBF=150 time:minutes, Qualifying Condition: numRequests<1000, Penalty: 5 USD, Importance 8

Guarantee2: SLO: qos:MTTR<5 time:minutes, Qualifying Condition: numUsers<500, Penalty: 3 USD, Importance 4

The ARL rule for Availability creates a new guarantee term for any agreement which has SLOs regarding both MTBF and MTTR. The new guarantee has an SLO for the Availability. Any Qualifying Conditions will be compounded and a Penalty/Reward will be the higher of the two. If each has the business value importance, it will become the average of the two values. The following ARL rule accomplishes the above:

when: Agreement (A) and hasGuarantee (A, G1) and hasSLO (G1, SLO1) and hasQualifyingCondition(G1, QC1) and hasPenalty(G1, P1) and hasImportance(G1, I1) and hasExpression (SLO1, E1) and hasParameter(E1, “qos:MTBF”) and hasValue(E1, X) and hasGuarantee (A, G2) and hasSLO (G2, SLO2) and hasQualifyingCondition(G2, QC2) and hasPenalty(G2, P2) and hasImportance(G2, I2) and hasExpression (SLO2, E2) and hasParameter(E2, “qos:MTTR”) and hasValue(E2, Y) do: hasGuarantee (A,G3) and hasSLO(G3, SLO3) and hasExpression(SLO3, E3) and hasParameter(E3, “qos:Availability”) and hasValue(E3, X+Y) and hasPenalty (G3, max(P1, P2)) and hasImportance(avg(I1,I2))

The rule will be fired once the provider agreement is loaded into Snobase and will add the following guarantee to the agreement:

Guarantee3: SLO: qos:Availability=96.8, Qualifying Condition: numUsers<500 AND numRequests<1000, Penalty: 5 USD, Importance: 6

4. User Preference Rules
The preference rules enable user assertions over subjective personal preferences. There is no standard of comparison for Qualifying Conditions and Business Values as they are a matter of user preference. For example, one service may be more active during the weekend in which case a provider with a condition stating that the objective may only be guaranteed if it is a weekday would not be suitable for that user. The matcher is unaware of the personal circumstances of each user until they are defined using rules. A rule may assert one of two possible assertions which will have an impact on matching: isPreferred or notSuitable. A user may write a rule to assert that “a guarantee that has a condition that the day of the week must be a weekday is not suitable” or “a guarantee with a condition involving transactionRate is preferred over a guarantee with a condition involving the day of the week”. These rules have the flexibility to be more specific or generic. The following ARL rule asserts that a weekday condition is not suitable for this user:

**when:** Agreement (A) and hasGuarantee (A, G1) and hasQualifyingCondition(G1, QC1) which hasExpression(QC1, E1) and hasParameter(E1, “time:dayOfWeek”) and hasValue(E1, “time:weekday”)  
**do:** assert Guarantee notSuitable G1

The above rule asserts that a guarantee is notSuitable if the parameter of the Qualifying Condition is the dayOfWeek and if the value is weekday. Conflicting rules are resolved by using optional priority and condition fields.

### 4.3 SWAPS SEARCH ALGORITHM

The system uses a two fold approach to finding the result set of providers. First, matching is automatically performed by the semantics of predicates rules as agreement instances are created. These rules significantly simplify the matching process because they compare the SLOs upon their entrance into Snobase. At this time assertions are made about which SLOs are stronger than or
equivalent to other SLOs these assertions are queried by the search engine. Second, searching is
done to determine which providers had agreements which were best suited for the consumer’s
agreement. We now detail the search algorithm. The following functions are defined to facilitate
the expression of the search algorithm:

“requirement(Alt, G)” returns true if G is a requirement of Alt

“capability(Alt, G)” returns true if G is an assurance of Alt

“scope(G)” returns the scope of G

“obligation(G)” returns the obligated party of G

“isStronger(Gj, Gi)” returns true if the SLO of Gj has an assertion isStronger than the SLO of Gi

“isEquivalent(Gi, Gj)” returns true if the SLOs of the guarantees have the assertion isEquivalent

“notSuitable(G)” returns true if G has an assertion notSuitable

As discussed in section 2.3, matching two agreements is reduced to finding two matching
alternatives and finding matching alternatives is reduced to finding matching guarantees.

(∀Gi) such that Gi ∈ Alt1 ∧ Alt1 ∈ A1 ∧ requirement (Alt1, Gi) ∧ (∃Gj) S.T. Gj ∈ Alt2 ∧
Alt2 ∈ A2 ∧ capability(Alt2, Gj) ∧ scope(Gi)=scope(Gj) ∧ obligation(Gi)=obligation(Gj) ∧
(isStronger(Gj, Gi) ∨ isEquivalent(Gi, Gj)) ∧ ¬notSuitable(Gj)

4.3.1 CLASSIFICATION OF RESULTS

The search algorithm will yield a Vector of potential providers where each provider contains at
least one alternative which can be fully satisfied and is also able to fulfill the requirements of the
consumer. This set will not contain any providers which have conditions that would not be suitable
for the consumer. As discussed earlier, each user will have a subjective personal preference
regarding qualifying conditions and business values. If the method for stating preferences was utilized then there may be isPreferred assertions stated over some of the guarantees. We implement a preference score for each alternative which is incremented for each isPreferred statement asserted over one of the guarantees of the alternative. The agreements containing alternatives with the highest preference scores are displayed first.

4.4 EXAMPLE

In this section we present an example to illustrate our approach. Table 3 shows simplified set of guarantees for a consumer. The consumer is seeking the potential providers from the library of providers given in Table 4. The tags and structure of the agreements are removed for simplicity and clarity.

4.4.1 PARSING, INSTANCE CREATION AND RULE EXECUTION

When the tool is started, each of the provider agreement documents in the library given in Table 4 are parsed and loaded into Snobase. An agreement instance is created for each provider alternative. Provider 3 will have two agreement instances associated with it because it has two alternatives. As each agreement instance is loaded, the rule engine executes the rules as the criteria for each is met. The user’s system includes all of the ARL rules from the previous examples in addition to a similar rule to define the semantics of “greater”. An additional domain rule exists for \( \text{responseTime} = \text{processTime} + \text{transmitTime} \) which follows the same procedure as the previous domain rule for \( \text{Availability} \) but sums the values. The following rule defines the semantics of the “true” and “false” predicates:
### Table 3. Summary of Consumer Guarantees

<table>
<thead>
<tr>
<th></th>
<th>Consumer1.wsag</th>
</tr>
</thead>
<tbody>
<tr>
<td>G1</td>
<td><strong>Scope:</strong> ProcessRequest, <strong>Obligated:</strong> ServiceConsumer <strong>SLOc1:</strong> qos:availableMemory greater 12 MB</td>
</tr>
<tr>
<td>G2</td>
<td><strong>Scope:</strong> ProcessRequest, <strong>Obligated:</strong> ServiceProvider <strong>SLOc2:</strong> qos:failurePerWeek less 7</td>
</tr>
<tr>
<td>G3</td>
<td><strong>Scope:</strong> ProcessRequest, <strong>Obligated:</strong> ServiceProvider <strong>SLOc3:</strong> qos:allowIncompleteInputs true</td>
</tr>
<tr>
<td>G4</td>
<td><strong>Scope:</strong> ProcessRequest, <strong>Obligated:</strong> ServiceProvider <strong>SLOc4:</strong> 99% of qos:responseTime less 14 seconds</td>
</tr>
</tbody>
</table>

### Table 4. Summary of Guarantees from Provider Library

<table>
<thead>
<tr>
<th></th>
<th>Provider1.wsag</th>
<th>Provider2.wsag (Provider2a and Provider2b)</th>
</tr>
</thead>
<tbody>
<tr>
<td>G1</td>
<td><strong>Scope:</strong> ProcessRequest <strong>Obligated:</strong> ServiceProvider <strong>SLO1:</strong> qos:responseTime less 14 sec. <strong>QC:</strong> time:dayOfWeek equals weekday <strong>Penalty:</strong> 15 USD</td>
<td><strong>Scope:</strong> ProcessRequest <strong>Obligated:</strong> ServiceProvider <strong>SLO5:</strong> qos:transmitTime less 4 sec. <strong>QC:</strong> qos:maxNumUsers less 1000 <strong>Penalty:</strong> 1 USD</td>
</tr>
<tr>
<td>G2</td>
<td><strong>Scope:</strong> ProcessRequest <strong>Obligated:</strong> ServiceProvider <strong>SLO2:</strong> qos:failurePerWeek less 7 <strong>Penalty:</strong> 10 USD</td>
<td><strong>Scope:</strong> ProcessRequest <strong>Obligated:</strong> ServiceProvider <strong>SLO6:</strong> qos:processTime less 5 sec. <strong>QC:</strong> qos:numRequests less 500 <strong>Penalty:</strong> 1 USD</td>
</tr>
<tr>
<td>G3</td>
<td><strong>Scope:</strong> ProcessRequest <strong>Obligated:</strong> ServiceProvider <strong>SLO3:</strong> qos:incompleteInputs true</td>
<td><strong>Scope:</strong> ProcessRequest <strong>Obligated:</strong> ServiceProvider <strong>SLO7:</strong> qos:failurePerWeek less 16 <strong>Penalty:</strong> 2 USD</td>
</tr>
<tr>
<td>G4</td>
<td><strong>Scope:</strong> ProcessRequest <strong>Obligated:</strong> ServiceConsumer <strong>SLO4:</strong> qos:availableMemory greater 12MB</td>
<td><strong>Scope:</strong> ProcessRequest <strong>Obligated:</strong> ServiceProvider <strong>SLO8:</strong> qos:incompleteInputs false</td>
</tr>
</tbody>
</table>
when any two guarantees from a different agreement instance have the same parameter and each predicate =”true” or each predicate=”false”

assert [SLO1 isEquivalent SLO2]

Table 5 shows the assertions as each agreement is parsed and entered into Snobase.

4.4.2 SEARCHING

The consumer is matched against each alternative of each provider. By querying for isStronger and isEquivalent assertions for the Provider’s SLOs, the algorithm determines that Provider 1 is able to satisfy the consumer’s needs and the consumer can also satisfy the requirement expressed in G1. However, Provider 1 is dismissed as a potential match because one of the guarantees was asserted as notSuitable as highlighted in number 3 of Table 5.

Provider 2’s first alternative is considered and the algorithm will determine that not all of the consumer’s guarantees are satisfied as the provider does not have an isStronger or isEquivalent assertion for each of them and as one of the SLOs is weaker than the consumer SLO as highlighted in number 9 from Table 5. The algorithm moves on to the next alternative of Provider 2 and determines that it is a match because all of the consumer’s guarantees are satisfied and none of the relevant provider guarantees have been asserted as notSuitable. The algorithm returns Provider 2 as the only match.
Table 5. SWAPS Matching

<table>
<thead>
<tr>
<th>Guarantee</th>
<th>Fact/Rule</th>
<th>Assertion</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Consumer</td>
<td>PercentageLessThan Threshold</td>
<td>qos:responseTime &lt; 14 seconds</td>
</tr>
<tr>
<td>G4</td>
<td>Threshold Conversion Rule</td>
<td></td>
</tr>
<tr>
<td>2 Provider1</td>
<td>Semantics of “less”</td>
<td>SLO1 isEquivalent SLOc4</td>
</tr>
<tr>
<td>G1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Provider1</td>
<td>User Preference Rule weekday not</td>
<td>Provider1’s G4 notSuitable</td>
</tr>
<tr>
<td>G1</td>
<td>Suitable</td>
<td></td>
</tr>
<tr>
<td>4 Provider1</td>
<td>Semantics of “less”</td>
<td>SLO2 isEquivalent SLOc2</td>
</tr>
<tr>
<td>G2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 Provider1</td>
<td>Semantics of “true”</td>
<td>SLO3 isEquivalent SLOc3</td>
</tr>
<tr>
<td>G3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 Provider1</td>
<td>Semantics of “greater”</td>
<td>SLOc1 isStronger SLO4</td>
</tr>
<tr>
<td>G4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7 Provider2a</td>
<td>Domain rule for “qos:ResponseTime”</td>
<td>Provider2a-G5-SLO13: qos:responseTime less 9 secs., Qualifying Condition:</td>
</tr>
<tr>
<td>G1 and G2</td>
<td></td>
<td>numRequests&lt;1000 AND numUsers&lt;500, Penalty: 1 USD</td>
</tr>
<tr>
<td>8 Provider2a</td>
<td>Semantics of “less”</td>
<td>SLO13 isStronger SLOc4</td>
</tr>
<tr>
<td>G5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9 Provider2a</td>
<td>Semantics of “less”</td>
<td>SLOc2 isStronger SLO7</td>
</tr>
<tr>
<td>G3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 Provider2b</td>
<td>Domain rule for “qos:ResponseTime”</td>
<td>Provider2b-G5-SLO14: qos:responseTime less 9 secs., Qualifying Condition:</td>
</tr>
<tr>
<td>G1 and G2</td>
<td></td>
<td>numRequests&lt;1000 AND numUsers&lt;500, Penalty: 1 USD</td>
</tr>
<tr>
<td>11 Provider2b</td>
<td>Semantics of “less”</td>
<td>SLO14 isStronger SLOc4</td>
</tr>
<tr>
<td>G5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12 Provider2b</td>
<td>Semantics of “less”</td>
<td>SLO11 isEquivalent SLOc2</td>
</tr>
<tr>
<td>G3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13 Provider2b</td>
<td>Semantics of “true”</td>
<td>SLO12 isEquivalent SLOc3</td>
</tr>
<tr>
<td>G4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4.4.3 POST SEARCH CONSIDERATIONS

There was only one potential match in the simplified example above. However, if there had been more compatible providers in the library, the algorithm would continue with additional steps. There are several issues of preference in the example above. If Provider1 had been a suitable match the responseTime is guaranteed to be less than 14 seconds with a very high penalty of 15 USD.
Provider 2 offers a much faster responseTime of 9 seconds but a much lower penalty of 1 USD. Some users may desire efficiency while others may wish to merely satisfy the objective while sacrificing some efficiency for the potential of a high penalty payoff. Since this is a personal user preference, the user may define a rule which states that a guarantee isPreferred if the penalty is over some threshold. The user may also wish to state that if the penalties are the same then faster speeds are preferred. During the matching process, the preference score for each alternative is incremented each time a satisfactory guarantee has the isPreferred assertion. When multiple providers are able to satisfy the basic needs of a consumer, the results are ranked by highest preference scores so that the user may consider the most preferred providers first. This example showed the reasoning process while illustrating the flexibility provided by the user defined rules.

4.5 EVALUATION

We now evaluate our tool by comparison with a syntactic matcher. We will discuss scenarios and how matchers using the following four approaches perform: a) a combination of OWL ontologies and rules, b) a syntactic approach which uses neither rules nor ontologies, c) an approach which uses only rules with no ontologies, d) an approach which uses only ontologies with no rules. The test scenarios are as follows:

**Test Case 1:**
- Consumer Requirement: responseTime < 5
- Provider Capability: responseTime < 4

All four approaches are able to successfully identify this match.

**Test Case 2:**
- Consumer Requirement: responseTime < 5
• Provider Capability: \((duration1+duration2) < 4\)

Our semantic approach takes advantage of the OntConcept annotation tag which identifies each of the parameters as the responseTime concept from the QoS ontology and is therefore able to identify what is meant by \((duration1+duration2)\). An approach which uses ontologies without rules was not able to identify this as a match since there is no way to specify such a rule in OWL. A syntactic approach which uses no ontologies or rules was not able to identify that \((duration1+duration2)\) and responseTime each mean the same thing. An approach which uses no ontologies but uses rules may be able to specify that \((duration1+duration2)=responseTime\). However, if the consumer uses a more ambiguously named parameter such as “rt”, the matcher is not able to determine that “rt” and “responseTime” have the same semantics.

**Test Case 3:**

• Consumer Requirement: responseTime < 5

• Provider Capability: networkTime < 2
  executionTime <1

Our semantic approach which combines ontologies with rules recognizes that responseTime = networkTime+executionTime and therefore determines An approach which uses ontologies without rules is unable to express this formula within the expressiveness of OWL, however, we chose to express this as an ARL rule to allow more flexibility. An approach which uses rules without ontologies is able to determine that networkTime+executionTime=responseTime, however, the execution of the rule itself relies on a syntactic match without ontological representation.

Therefore, if the provider capability is represented as: nt<2 and et<1 the matcher cannot syntactically determine that those concepts represent the networkTime and executionTime. Our approach uses the ontConcept tag to annotate the SLO with concepts from ontologies to
Table 6. Evaluation Results

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>responseTime &lt; 5</td>
<td>responseTime &lt; 4</td>
<td>YES</td>
<td>YES</td>
<td>YES, but only if parameters are named syntactically similar</td>
<td>YES, but only if parameters are named syntactically similar</td>
</tr>
<tr>
<td>responseTime &lt; 5</td>
<td>(duration1 + duration2) &lt; 4</td>
<td>YES</td>
<td>NO</td>
<td>YES, but only if the parameters are named syntactically similar to the rule criteria</td>
<td>NO</td>
</tr>
<tr>
<td>responseTime &lt; 5</td>
<td>rt &lt; 4</td>
<td>YES</td>
<td>YES</td>
<td>NO</td>
<td>NO</td>
</tr>
<tr>
<td>responseTime &lt; 5</td>
<td>networkTime &lt; 2</td>
<td>YES</td>
<td>NO</td>
<td>YES, but only if the parameters are named syntactically similar to the rule criteria</td>
<td>NO</td>
</tr>
</tbody>
</table>

An approach which uses neither rules nor ontologies fails to detect this match since neither executionTime nor networkTime when compared directly with responseTime will yield a syntactic match. Table 6 summarizes these results.
APPLICATION OF AGREEMENTS AND AGREEMENT MATCHING

This section does not attempt to show another technical example but rather describes how WS-Agreements and our tool can be applied to remedy a challenging real world situation. The next sections will describe the problem, how WS-Agreements can be applied, and how the WS-Agreement matching tool can solve this problem.

5.1 AGRICULTURE IN INDIA

Agricultural trade in India is problematic for both Farmers and Merchants and there is a lack of effective use of IT to facilitate trade. Farmers spend time and resources growing goods and sending them to the markets without guarantee that they will be sold. The farmer pays for the transportation of the goods and the wastages that occur when the goods spoil during transport. Merchants have no assurances on the quality or availability of the goods that they seek to purchase. This problem is addressed in [4] and the authors describe an Agricultural Information System to improve the effectiveness of decision-making in the agriculture domain. A Web Services based business process management system developed to aid the marketing of agricultural produce is described in [18]. Each party involved is represented as a Web Service. If each party is a Web Service, then the process of matching farmer to merchant can be reduced to one of Web Service composition and policy matching.
Contract farming is one remedy currently being practiced to solve the dilemma and is described in [6] as a system for the production and supply of agricultural products under forward contracts between producers/suppliers and buyers. The cultivator makes a commitment to provide an agricultural commodity of a certain type, at a time and a price, and in the quantity required by a known and committed buyer. Using farming contracts, growers and buyers can agree to terms and conditions for the sale and purchase of goods. The buyer can make agreements to supply selected goods which sometimes also include land preparation and technical advice. The contracts ensure that the grower follows recommended production methods and cultivation and harvesting specifications. Conditions are frequently stated regarding the price and quality of goods and penalties in the form of discounts are offered for flaws or lack of quality.

Table 7. Farming Contracts represented with WS- Agreement

<table>
<thead>
<tr>
<th>Merchant</th>
<th>Farmer 1</th>
<th>Farmer 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guarantee1: SLO1: Moisture is less inclusive 12%</td>
<td>Guarantee1: SLO1: Moisture is less 10% Penalty: discount $10 each</td>
<td>Guarantee1: SLO1: Moisture is less inclusive 12% Penalty: discount $15 each</td>
</tr>
<tr>
<td>Guarantee2: SLO2: splits is less inclusive 20%</td>
<td>Guarantee2: SLO2: splits is less inclusive 20% Penalty: splits of 5% or more, discount $1 each</td>
<td>Guarantee2: SLO2: splits is less inclusive 20% Penalty: splits of 3% or more, discount $5 each</td>
</tr>
<tr>
<td>Guarantee3: SLO3: test weight is greater than 54 lbs</td>
<td>Guarantee3: SLO3: test weight is greater than 60 lbs</td>
<td>Guarantee3: SLO3: test weight is greater than 58 lbs</td>
</tr>
</tbody>
</table>

The situation for farmers is improved as they no longer must send goods to markets without a guarantee of acquisition. The farmer’s price risk is reduced because the contracts specify the prices in advance. The buyers obtain more consistent quality and more reliable production than if
purchases were made on the open market. When efficiently organized and managed, contract farming reduces risk and uncertainty for both parties as compared to buying and selling crops on the open market. The success stories of E-Chaupal and Tata Kisan Sansar, who have implemented contract farming in India, are discussed in [18]. Just as Web Services can represent the farmers and merchants, the WS-Agreement is well suited to represent the complex contracts drawn between the two.

5.2 CONTRACTS AS WS-AGREEMENTS

The WS-Agreement is perhaps the best suited standard for representing farming contracts. The protocol is functional for representing the guarantees which always include some objective and often contain conditions which must exist in order for the objective to be fulfilled. For example, a merchant may guarantee a price under the condition that the goods are of a certain quality. Business values such as penalties are often seen in contracts in the form of discounts. For example, a farmer may guarantee that the moisture percentage is than 10% and may offer a discount for every bushel that contradicts that assurance. In this case, a merchant is considered to be a service consumer and his guarantees and requirements can be proficiently represented using WS-Agreement. The available merchants are the service providers. Table 7 contains an example of farming contracts as WS-Agreements. It depicts the merchant as the consumer seeking the most suitable farmer, however, this tool can also be used by a farmer to find the ideal merchant. Section 5.3 will discuss how SWAPS can easily match a merchant with a farmer who will provide the required quality at a desired price.
An ontology representing the Agriculture domain can provide the matcher with a complete understanding of the domain and the user can supplement this knowledge with rules specific to the domain. The user can also write any relevant conversion rules for measurements. For example, the user may write a rule to convert from ounces to grams or from bushels to pounds. For predicates, this user may which to use the basic predicates already defined within the system or can also add domain specific predicates. The simple example in Table 7 uses predefined predicates. In this domain, price is compared differently than moisture or splits because, with the latter, both parties specify that the number must be less than some value because while moisture may vary per bushel it must always be less than some value. Price, however, is a fixed price per bushel. Therefore, when comparing price, expressions with different predicates may still be compatible. For example, the merchant is willing to pay five cents or less but the farmer is asking 4 cents or greater per bushel. Since a parameter such as price will be reasoned over differently than a parameter like moisture, a separate rule must be defined to define the procedure for comparing price. The user will surely have personal preferences and may define these as rules. In Table 7, Farmer 1 clearly offers better quality goods while Farmer 2 offers much higher penalties. The merchant may specify the tradeoff as an ARL rule which states that high penalties are preferred. This causes Farmer 2 to be presented as a higher match than Farmer 1. This tool can effectively narrow down the hundreds of farmers into a group which contains only those farmers offering what the merchant requires. The merchant can specify additional preferences and aspects which are notSuitable to further narrow down the search. Finally the merchant is presented with one or more farmers, in order of preference, from which to choose. This feature greatly reduces the search effort for both farmers.
and merchants. It can ensure that each farmer and merchant gets the best possible deal tailored to their individual needs and preferences.
CHAPTER 6
RELATED WORK

There has been very little work done in the area of WS-Agreement. A formal definition of the WS-Agreement is given in [1] and the schema is extended by adding tags to accommodate states for negotiation. Cremona [11] is a tool for the creation and monitoring of WS-Agreements. Both contributions do not consider partnering agreements. Major work in the domain of Service Level Agreement (SLA) matching is purely syntactic. [28] developed a methodology for matching Web Service Level Agreements (WSLA). This work syntactically matches SLAs by parsing them into syntax trees. The authors have designed a matching algorithm which compares these trees node by node. Heterogeneous SLAs are handled by referencing a table containing instructions which the code must execute in order to convert them into the same format. Such syntactic approaches must take a more exhaustive and laborious approach to matchmaking and are challenged by less obvious matches. Since our agreements are parsed into instances of the WS-Agreement OWL ontology, we are able to reason over the ontology and retrieve data via ontology queries with much less effort. In addition, the semantics defined by this ontology result in more accurate matches. This work focuses on matching Service Level Objectives, where, our work considers compatible scopes and SLOs to be the most essential criteria for matching but also reason over qualifying conditions and business values. GlueQoS [29] extends the grammar of WS-Policy to add qualifying conditions. This approach uses only XML based models which limits the expressivity of the assertions. Since XML cannot express formal meaning, the matching is purely syntactic which greatly limits efficiency of the matching process. Our work uses the combination of OWL ontologies and ARL
rules to provide our matcher with detailed knowledge of the domain, QoS, and agreements which leads to better matches.

The following work uses rules without semantics to represent policies. Paschke et al use a rule based SLA language (RBSLA) to express Service Level Agreements in [16]. RBSLA is an extension of RuleML tailored to satisfy the requirements of the SLA domain. The rules are based on the logic components of Derivation, Event Condition, Event Calculus, Courteous Logic, Deontic Logic, and Description Logic. Rule based SLAs can be written and modified using the management tool (RBSLM) which also enables the management, maintenance and monitoring of contract rules. Policy matching is not considered in the scope of this approach. There has also been some work that has benefited from using Semantic Web technologies. Uszok et al have developed KAOS for the specification, management, analysis, and enforcement of policies [20]. The policy is represented using concepts from an OWL ontology. Role-value maps are added to later work to compensate for some of the limitations in expressiveness of OWL. The trust and privacy of Web services is handled with a rule based engine in [7], and in [8], the authors discuss the combination of OWL ontologies and SWRL rules. Parsia et al present the OWL ontology developed for representing policies however they do not utilize rules [15]. Li et al apply a very interesting approach to Access Control Policy specification [10]. Access Control Policies are designed and expressed using a combination of OWL and SWRL. Policies are defined using an ontology. SWRL is introduced to enhance OWL with additional expressiveness and deducible ability. Access control policies are designed in the form of rules using concepts defined in the ontology and relationships such as isPermittedDoWith to express which kinds of agents have permission to access resources. This work aims to express policies and does not consider the matching of these policies. Verma et al presents a successful approach to policy matching by combining semantics
with rules to achieve efficient matches. WS-Policy is extended to incorporate semantics and policies are represented using an OWL ontology. SWRL rules express additional domain concepts and expand the matching ability. Our work applies a similar approach to WS-Agreement and extends it to also reason over scope, qualifying conditions and business values. We provide matching flexibility by allowing users to define their own predicates and preferences.
CHAPTER 7
CONCLUSION AND FUTURE WORK

This work presents a novel contribution to the area of WS-Agreement and agreement matching. With the framework and implementation described throughout this paper, service providers and consumers may automatically make the most accurate and effective partnerships which are tailored to user preferences. While this objective has been considered in the prior works, we extend this by defining reasoning methods for the Scopes, Obligations, SLOs, Qualifying Conditions, and Business Values of the Guarantee Terms. We consider the subjectivity of the latter two and implement a feature which allows for the specification of what the user prefers and what the user considers unsuitable. We effectively match complex agreements containing multiple alternatives and symmetry such that both consumer and provider have capabilities and requirements. This work utilizes an effective combination of ARL rules with multiple Ontologies in order to achieve flexibility and accuracy. In the process it demonstrates the need and value of annotating multiple activities (e-commerce in our example) with non-functional and domain-independent ontologies. The use of WSDL-S for semantic Web Services is also demonstrated in this context. We define several categories of rules to enhance domain specific knowledge, efficiently handle heterogeneous SLOs, allow the definition of user preferences, and flexibly allow domain specific predicates while greatly simplifying the matching process. These rules are a powerful addition because they allow the matching process to be changed and customized at any time without any modifications to the code or programming knowledge.
Since a key feature of our work is to customize the matching process with user defined rules, this work will benefit from a module which converts rules defined with SWRL to ARL rules to facilitate the definition of rules by user. This tool can be extended to incorporate negotiations as defined by the protocol in [2]. Suitable agreements can be identified by the current tool and negotiations between parties could ensue. This tool can also be augmented to support other standards for policy specification such as WS-Policy. This would allow consumer to provider matches regardless of the specification used. This kind of matchmaking can be integrated with the METEOR-S configuration and runtime binding middleware [22].
REFERENCES


APPENDIX A – WS-AGREEMENT ONTOLOGY

[http://lsdis.cs.uga.edu/~oldham/ontology/wsag/]

© Agreement
© AgreementContext
© AgreementInitiator
© AgreementProvider
© BusinessValueList
© Expression
© GuaranteeTerm
© Importance
© Name
© Penalty
© PenaltyAssessmentInterval
© Preference
© QualifyingCondition
© Reward
© RewardAssessmentInterval
© ServiceDescriptionTerm
© ServiceLevelObjective
© ServiceProperty
© ServiceReference
© ServiceScope
© SLA_predicate
  © after
  © before
  © equal
  © false
  © greater
  © greaterEqual
  © less
  © lessEqual
  © mean
  © median
  © numberGreaterThanThreshold
  © numberLessThanThreshold
  © percentGreater ThanThreshold
  © percentLessThanThreshold
  © true
- TerminationTime
- Terms
- Variable
- Variables
APPENDIX B – SWAPS INSTALLATION MANUAL

[http://lsdis.cs.uga.edu/projects/meteor-s/swaps]

REQUIREMENTS

1. Eclipse 3.0 or later, http://www.eclipse.org/

2. JDK 5.0, http://java.sun.com/j2se/1.5.0/download.jsp

To configure Eclipse to JDK 5.0 use the following instructions

   a. Open Eclipse and make sure you are in the Resource perspective (window -> open
      perspective -> others -> Resource)

   b. Check if JDK 5.0 has been recognized as installed JRE (window -> preferences ->
      java -> installed JREs). If you don't find JDK 5.0 in there add a new JRE pointing to your
      JDK 5.0 installation.

   c. set the JDK 5.0 JRE as default

3. IBM Ontology Management System (SnoBase)


   Download and extract Snobase_1_1.zip

INSTALLATION

1. Download the WsagSelection Project from here.

2. Extract the "WsagSelection" project directory from the zip archive and copy it into the Eclipse
   workspace directory.
3. Copy the “com” folder from SnoBase_1_1/bin into the WsagSelection folder that you just copied into the Eclipse workspace directory.

4. Move the OWL arl file from the WsagSelection project folder into
\com\ibm\jobc\ob2\inferencing\ABLE

5. Start Eclipse and import the WsagSelection project into workspace.

This can be done as follows:

File -> Import -> Existing project into workspace

On the project import screen, browse to the Eclipse workspace folder and select "WSAGSELECTION" directory. Click Finish

6. The project is now imported into the workspace.

7. Get into the Java Perspective (window -> open perspective -> others -> Java)

8. Configure Eclipse for SnoBase.

   Import SnoBase library files. Project->Properties->Java Build Path, select the “Libraries” tab and click the “Add External Jars…” button. Navigate to the SnoBase_1_1/lib folder and select all of the jar files, click “Open”.

9. Compile the project and run

10. Now the WS-Agreement Matching tool is ready to be used. Please refer to the User's Guide for using the tool.
First follow the installation guide to download and configure SWAPS.

CUSTOMIZING THE MATCHER

SWAPS can be fully customized by adding or modifying the rules in OWL.arl which was copied into the SWAPS_HOME/com/ibm/jobc/ob2/inferencing/ABLE folder during installation.

Instructions for writing ARL rules can be found at:

http://www.eng.auburn.edu/users/sapleav/COMP%208700/ABLE/reference/com/ibm/able/rules/doc-files/IngIndex.html#toc

1. Semantics of Predicates

SWAPS is automatically configured to match the requirements and capabilities using the predicates Less, LessEqual, Greater, GreaterEqual, True, False, Equals.

To add a new predicate for a domain add it under the “Predicates” concept in the WS-Agreement ontology, wsag.owl, in SWAPS_HOME/ontology_store. You must also write an ARL rule which defines the semantics of the predicate. The rule should specify how to compare two SLOs by asserting isStronger or isEquivalent assertions.

For examples see the Rules section at http://lsdis.cs.uga.edu/projects/meteor-s/swaps/

2. Heterogeneous SLOs

SWAPS is automatically configured to convert the predicates PercentageLessThanThreshold, NumberLessThanThreshold, PercentageGreaterThanThreshold, and
NumberGreaterThanThreshold. These rules can be made more specific. The percent value, which is currently defined at 95%, can be changed.

For examples see the Rules section at http://lsdis.cs.uga.edu/projects/meteor-s/swaps/

3. **Domain Specific Rules and User Preferences**

Rules which are specific to the domain or user preference can be added. UserPreference rules should assert `notSuitable` or `isPreferred`.

For examples see the Rules section at http://lsdis.cs.uga.edu/projects/meteor-s/swaps/

---

**THE PROVIDER LIBRARY**

Upon startup the provider agreement files located in SWAPS_HOME/providers are loaded into the system. They are displayed in the provider library window shown in Figure 6 and the guarantee...
terms for a provider can be viewed by selecting the provider. The guarantees show in the “Provider Agreement” window.

**ADDING PROVIDERS**

New Providers which are not already in the library can be added by selecting File->Add a Provider. Select the provider agreement file in the dialog box and click on the open button. The new provider appears in the list of providers in the library and the guarantees can be viewed in the “Provider Agreement” window by selecting the new provider in the list.

**SELECTING A CONSUMER FOR MATCHING**

To select a consumer for matching select File->New Consumer. When the file dialog box opens, select the consumer agreement and click open. The consumer agreement is loaded into the system and the guarantees are shown in the “Consumer Agreement” window shown in Figure 7.

![Semantic WS-Agreement Partner Selection](image)

![Consumer Agreement](image)

*Figure 7. Consumer Selection*
MATCHING

In order to determine which providers from the list are suitable matches select Match->Find Matches. A tab menu will appear with the guarantees of the matching providers in each tab. A preference score indicates the number of user preferences that were found within the agreement. These serve to facilitate the user’s decision. The “Match Log” window describes the matching decisions. Figure 8 shows the results.

---

Figure 8. Match Results